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Cyber Security starts in school

Sandra Engle, Technology Integration Manager at Rome
Catholic School, will explain how technology is integrated
into the curriculum to keep the school environment
“Cyber Safe and Computer Protected”.

Sandra has worked at RCA as a library media
specialist/technology teacher since 2002 and served in a
similar position at Transfiguration Elementary School in
Rome.

She helped implement a partnership grant between the school, Syracuse
University and the US Air Force to develop the first high school elective in
Studies in Cyber Security.

Topics that Sandra will cover:

“Cyber Ethics - Guidelines / Computer Etiquette for Teachers /
Rules for Students”

The consortium of area colleges and businesses, working
together to create “Cyber Pathways” for careers in cyber security.
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The MVPCUG EXPLORER is published monthly from

September through June by the Mohawk Valley Personal Computer

User Group, Inc.(MVPCUG), PO Box 586, Marcy NY 13403-0586.

Opinions expressed herein are the writers and are not reflective of

the MVPCUG, nor are they considered substantiated by inclusion in

this newsletter. All articles are copyrighted by their respective

authors but may be reprinted by other User Groups provided credit is

given to the author and this publication.

The. MVPCUG was founded in 1981 by individuals interested in

IBM compatible computers. This non-profit organization consists of

volunteers whose expertise range from novice to professional.

Regular meetings are held on the first Tuesday of the month at

6pm, usually at the Whitesboro High School, Route 291, Marcy NY.

A typical agenda consists of discussion of business affairs and a

demonstration of computer related products.  Meetings are open to

the public.

Initial membership fee for an individual is $25. Annual renewal

dues are $20.
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Editorial notes . . .
   Many computers on the market
today feature 64 bit processors.
Microsoft says that Vista runs
well using the 64 bit chips.
However, you may need to update
drivers. Also, some of your programs may not run well
even though Microsoft says most 32 bit programs will
run on a 64 bit system. The clue here is Microsoft. Can
they insure that some other software will run as
efficiently? If it won’t you will have to buy new software.
   When purchasing a new computer, take the time to
investigate thoroughly. Will you be able to run your
current programs? Is there a DVD writer as well as a
reader? Do you really want Vista?
   Make a list of your needs or wants—each of us uses
his/her computer differently. What do you want to do?
Before you buy, make sure you get all your questions
answered.

Meeting Agenda

5:30. . . . . . . . . . . . . . . . Meet and Greet
6:00. . . . . . . . . . . . . Business Meeting
6:30. . . . . . . . . . . . . . . Program, Part 1
7:10. . . . . . . . . . . . . . . . . . . . . . . . Break
7:20. . . . . . . . . . . . . . . Program, Part 2
8:00. . . . . . . . . . . . . Drawing for Prizes
8:15. . . . . . . . . . . . . . . . . . Adjournment
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The MVPCUG general meeting was held at the Whitesboro

HS cafeteria. President Jerry Finkelstein called the meeting to

order at 6:06 PM. There were 19 persons in attendance.

BUSINESS MEETING
Jerry started the meeting by requesting a treasury

report from Bill Gorrell for the period of Mar.1 to
Mar.31, 2009. The club received $406.45 in revenues
and spent $915.80 leaving a net expense for the
month at $509.35.  Account balances as of Mar.31,
2009 includes $130.09 in the checking account and
$1,920.14 in the money market for a total of
$2,050.23

Next Bill announced that the audit of the club’s
financial records has been completed and a full report
will be given at the next meeting. 

Jerry announced that the club is holding a
Chinese-Auction on the club’s excess computer
equipments. He asked those interested in bidding to
submit their buying price in specially marked
envelopes. At the end of the meeting the winners will
be announced.

PROGRAM
Tonight’s program consisted on eWaste

management with emphasis on Go-Green, by
recycling. Dave Lupinski from the Oneida-Herkimer
Solid Waste Authority, gave an excellent program by
explaining just what items can be accepted for
recycling and what items cannot. The items that are
NOT considered recyclable are to be disposed in trash
bags. Next Dave showed on his PowerPoint screen
the new state of art facilities on Leland Ave, North
Utica, also the new disposal dump sites in Ava, NY. 
Dave mentioned that home computers and its
equipment plus television sets, etc., can be dropped
off at the Leland Ave. site from 8:00 AM to 4:00 PM
on Mon thru Fri and 8:00 AM to 2:00 PM on
Saturday. There were plenty of literatures for the
members to take and read especially on Electronics
recycling.  For more info: www.ohswa.org.

Patty Bruno played a short movie on how all the
illegal dumping of old computers are being sent to
China and Nigeria and is creating havoc on the
environment. It is best to seek out reputable recycling
centers when disposing your computers, and always

remember to destroy your hard drive. 

DOOR PRIZES
[furnished with club funds]

Flash Drive-4gb. . . . . . . . . . . . . . . . . . Donna Gorrell
Photo Paper, 4X6.. . . . . . . . . . . . . . . . . . Joe Penabad
Mouse Pad. . . . . . . . . . . . . . . . . . . . . . . . . Lou Barile
DVD-R, 25 Pk. . . . . . . . . . . . . . . . . . . . Steve Gorrell

[Donated by Que Publishing]

Book on Windows Vista. . . . . . . . . Nelson Robinson

CHINESE AUCTION WINNERS:
Computer System, highest bid of $157.00, awarded to
Don Jennings
Printer at $5.00, Hard Drive at $20.00 and two
speakers at $20.00, all awarded to Nelson Robinson.

The meeting adjourned at 8:25 PM.
Helen Russell, secretary g

�  �  �  �  �  �  � 

HELPFUL IDEAS

Microsoft has changed the format in its new Office
2007 package, but most of us are still using older
versions. If someone sends you a document with the
new extension .docx, your old version will not be able
to read the document. However, Microsoft has a
compatibility pack that updates your old version of
Office 2000, Office XP, or Office 2003 to let you
open, edit, and save Office 2007 file formats [such as
.docx]. http://tinyurl.com/y5a879. If you use Word
2000 check this site: http://tinyurl.com/y9rswj.

And if you or someone you know still uses Wordstar,
Lotus AmiPro, or even dBASE II files, there’s an
official converter pack for you, too at:
http://tinyurl.com/4hb7jf.

Google has a two-page PDF with lots of valuable
Google shortcuts, search and query examples, and
services. Download it at:
http://www.feedsforme.com/google/.

Find how to use search features of Google at:
http://www.google.com/help/features.html. g

  Minutes of April 7, 2009
— HRussell, Secretary  

http://www.ohswa.org
http://tinyurl.com/y5a879
http://tinyurl.com/y9rswj
http://tinyurl.com/4hb7jf
http://www.feedsforme.com/google/
http://www.google.com/help/features.html
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OFFICE 2007
Work on Large Documents

In Word and Excel, you can split the screen to see
two separate parts of a document at once. On the
View tab, in the Window section, click Split, and
then click the screen where you want the split to
appear. You can then navigate parts of the document
separately in each window. Excel adds both a
horizontal and a vertical split to the screen. If you
don't want one of them, drag the line up to the top or
the left side and drop it at the edge of the screen,
where it will disappear. To return to the single-screen
view of the document in either Word or Excel, go
back to the Window section and click Remove Split.

POWERPOINT
Create a Photo Album

Using the Photo Album feature in PowerPoint
2007, you can create a photo album presentation with
pictures consistently sized, placed, framed, and even
captioned. To create a photo album, on the Insert tab,
click Photo Album. In the Photo Album dialog box,
click File/Disk under Insert picture from to locate and
select your pictures. You can edit pictures, add
captions to pictures, and customize the picture layout
and framing format, all from the dialog box. When
finished, click Create to generate the presentation. To
enable captions, in the Picture layout box, select a
layout other than the default Fit to slide layout. If you
have enabled captions for all pictures, the default
caption text is the picture file name. Note that if you
don’t select a theme in the Photo Album dialog box,
your album uses the Office theme. You can apply a
different theme at any time from the Design tab. You
can edit album slides directly as in any PowerPoint
presentation. Or on the Insert tab, click the arrow at
the bottom of the Photo Album icon, and then click
Edit Photo Album.

VISTA
Access Programs Quickly

If you want to access to programs quickly from the
Quick Launch bar do the following: Click the Start
button, click All Programs, find and right-click your
program, then click Add to Quick Launch.

EXCEL
Easily Insert Rows or Columns in Excel 

With an Excel document open, you can insert extra
rows and columns by holding down the SHIFT key
while you grab a cell by its handle and drag it. Excel
will insert as many cells as needed.
Share Custom Chart Types

To save your active Excel chart as a template that
you can reuse or share, on the Chart Tools Design tab,
in the Type section, click Save as Template. In the
Save Chart Template dialog box, type a name for your
new chart type, and then click Save. To create a chart
based on a chart template, on the Insert tab, at the
bottom-right corner of the Charts section, click the
dialog box launch icon to open the Insert Chart dialog
box. Then click Templates to access your saved
custom chart types. Each chart template is saved as an
individual file that you can copy and share. Saved
chart templates are located in your Office user
templates folder, inside a subfolder named Charts. To
locate your user templates folder, click the Office
button, and then click Excel Options. Click the Trust
Center tab, and then click Trust Center Settings. In the
Trust Center dialog box, on the Trusted Locations tab,
double-click the entry Excel default location: User
Templates to view the full file path.

WORD
Create Tables to Your Own Specifications
Want to add a table with specific dimensions to your
Word document? Here’s how:
1. Position the cursor on the area of the document

where you want to insert your table.
2. On the Insert tab of the Ribbon, click Table, and

then click Draw Table.
3. Define the table size. Right-click to select the area

where you want the table to appear.
4. Use the mouse to draw the internal table lines the

way you want them. To erase any lines, press the
SHIFT key, and the pointer will change from a
pencil to an eraser.

Note: The design tools in Word gives you more
features—for example, the ability to create other
tables within those you’ve already designed.
Find Tooltips for Keyboard Shortcuts

If you press and hold the ALT key, tooltips appear
above the commands at the top of the page. You can
then press the appropriate letter for a simple keyboard
shortcut. g
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TAKE YOUR BOOKMARKS WHEREVER YOU
GO

Bill in Sacramento, CA, tunes in on KSTE 650 AM.
He would like to access his bookmarks wherever he
goes. For example, he would like to access them from
his clients’ offices. He would also like to access them
from his parents’ house. 

Not being able to locate the site you want is
frustrating. So, of course you want to take your
bookmarks. They make things so much easier.
Fortunately, this can be accomplished easily. You
have a few options.

You could download a copy of the portable Firefox
[www.portableapps.com]. This installs on a thumb
drive. The program takes up 16.9 MB on a thumb
drive. Then, you’d import your bookmarks from your
computer’s browser. These would be stored with the
portable Firefox. You can then access Firefox—and
your bookmarks—on any computer.

The other option is similar. You can export your
bookmarks from Firefox or IE. They would be stored
in an HTML file. You could also store this on a
thumb drive. Open the file in any browser. Just click a
link to open a bookmark. My tip makes exporting
your bookmarks a snap! 

Let’s look at Firefox first. Click Bookmarks |
Organize Bookmarks. Click File | Export. If
necessary, click Browse Folders. Select Desktop [or
wherever you prefer] and click Save. That sends the
file Bookmarks.html to the Desktop. Back it up with
your other files, or move it to the drive where you
keep your backups. 

The process is similar in Internet Explorer. Click
File | Import and Export. A wizard will open. Click
Next. Select Export Favorites and click Next. Select
Favorites and click Next. Select Export to a File or
Address. Click Browse. Select Desktop and click
Save. Click Next | Finish. Note that the IE7 file name
is Bookmark.htm. That is slightly different from the
Firefox file—Bookmarks.html. In both cases, the files
have been saved to the desktop. But you don’t want to
leave them there. The most likely tragedy to befall
your computer is hard drive failure. In that case, files

saved on the desktop would be lost. So move those
files to another drive.

You may not want to carry a thumb drive around.
And synchronizing your bookmarks with the drive
would be a hassle. So, I have a better solution. Use a
social-bookmarking site.

Sites like del.icio.us let you import bookmarks
from your browser. You can also add bookmarks
through browser add-ons. The bookmarks are stored
online. You can access them from any computer.

Also, if you use Firefox, you may be interested in
Foxmarks [www.foxmarks.com]. It is designed to
synchronize your Firefox bookmarks on multiple
machines. It also automatically backs up your
bookmarks after each change. This is really handy!
Better yet, you can access your bookmarks from any
browser. This Firefox add-on keeps Bookmarks
synchronized between two or more computers. You’ll
love it! You can even access your Bookmarks from
your phone’s browser. It doesn’t matter what browser
your phone uses. The Bookmarks are stored online.

<><><><><><><>

DELETING URL ADDRESSES IN BROWERS

Finally, you asked about deleting addresses. That is
easy, so long as you want to delete all addresses. In
Internet Explorer, click Tools | Options. Select the
Content tab. Under AutoComplete, click Settings.
Uncheck “Web addresses.” Click OK | OK.

Firefox is more complicated. In the address bar,
enter “about:config” [without the quotation marks].
Click Enter. This will take you to many settings. In
the Filter: box at the top, enter “urlbar” [no quote
marks]. This will automatically take you to a much
smaller group of settings. 

You need to change two of the settings. Right-click
browser.urlbar.matchOnlyTyped. In the menu, click
Toggle. That will change the default setting of false to
true. Next, right-click
browser.urlbar.maxRichResults. Click Modify. The
default setting is 12. Change it to 0.That’s it. Close
the about:config tab by clicking the X.

Copyright 2009 W estStar TalkRadio Network. Subscribe to

Kim Komando's free e-mail newsletters at:

www.komando.com

    BOOKMARKS–URLs
— Kim Komando    

http://www.portableapps.com
http://www.foxmarks.com
http://www.komando.com
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Talk to a Real Person

I
f you are like me, you do not appreciate company
telephone centers that force you to talk to a
machine rather than a person. One way to avoid

the 10 or more number options the phone gives you
when you call a corporation is to visit
www.get2human.com. This free service will give you
the direct lines and/or extension numbers for 1000 or
more of this countries’ largest corporations where you
will connect immediately to a live person.

The homepage presents a list of options along the
left side of the screen which include: search for name;
country search; industry search. You can also
download a list of all companies in this data base or
find what you are looking for by using the first letter
of the company name to aid you. I chose to enter
Verison Wireless and immediately a screen appeared
that listed contact directions from a cell phone or a
land line. Following the screen directions, I dialed the
800 number and then pressed “0" and was connected
to a human.

You can even get a list of companies with
exemplary customer telephone service. And you can
add your comments about service horror stories you
have experienced in a related blog.

The site also provides directory assistance from
your cell phone [Microsoft is best for this] and
AT&T. Microsoft will even connect you and send you
the number as a text message. Happy dialing and good
luck.

Who Runs Government?
If you want to find out information about the men

and women who run the new administration in
Washington, click on www.WhoRunsGov.com. This
site provides very useful biographical information
about our new leaders in all branches of government
and the military. The site is part of the Washington
Post Publishing Company and is free for the asking.
At my visit, I clicked on military and was presented a
list of the top 15 pentagon people. I chose Preston M.
Geren, Secretary of the Army. 

Why He Matters. The subsequent explanation
indicates why the Bush appointee is still running the
Army, and provides a short Vita listing previous posts
and educational background. The site also provides a
list of current and past issues the secretary confronts

including health care issues and procurement
contracting. The site lists all major officials or “likely
officials.”

In addition to personnel information, the site also
presents links to major Washington Post stories. At
my visit, one of the headlines read “Detainees Harsh
Treatment Foiled No Plots” Sunday, March 29, 2009.

This is a very useful site and I encourage you to
visit it.

New York State Saves Energy
New York State ranked fifth in the nation in 2008

for “demonstrating great leadership in promoting
energy independence with cost-effective energy
efficiency investments.” The 2008 report is the
American Council for an Energy-Efficient Economy’s
annual assessment of state efforts to adopt and
implement wise energy efficiency policies. The report
notes leadership among the states and identifies best
practices, ranking states on a broad array of energy
initiatives including: transportation, land use, building
energy codes, energy efficiency in public buildings
and so on. To read the free report visit
www.ACEEE.org/[pubs/EO86.htm. Or you can order
a hard copy for $30 plus $5 for postage.

Categorize and Assess Risk
We all face risks of one kind or another. Some

risks are imminent and some are very unlikely.
Planning for emergencies requires that individuals
and businesses identify risks and assess the likelihood
of their occurrence. A helpful chart that appears in the
Building Operating Management Magazine, March
2009 will assist you in assessing risks of all kinds.
You can access the article at http://tinyurl.com/cf4l55. 

The graph presents “severity on one side and
likelihood on the other” with minimal risk, tolerable
risk, moderate risk, substantial risk and critical risk as
the occurrence level of 1 to 3 is plotted against the
consequences 1 to 3.

Factoid
The Economic Policy Institute reports that the ratio

of unemployed people for each job opening is 3.3 to 1
as of October 2008. The Institute observes that if
unemployment hits 9 percent as projected by some
economists, the ratio could increase to more than six
unemployed workers for every job. For more unhappy
statistics visit www.epi.org/publications.

Until next time . . . g

   Sites to Visit on the ‘Net
— by John Hunter    

http://www.get2human.com.
http://www.WhoRunsGov.com
http://www.ACEEE.org/[pubs/EO86.htm.
http://tinyurl.com/cf4l55
http://www.epi.org/publications
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.. . . . that Firefox users should be aware of Results
Prefetching? Firefox may download information from sites
you’ve never visited. When Google returns the results, the
top site could be pornographic. Google tells your
computer to download images and a cookie from the site
to your computer. Thus, it could appear that you visited a
porn site from your work computer. You can turn Results
Prefetching off. Open Firefox and type “about:config”
[minus quotes] in the address bar. About:config is a
special page in Firefox which allows you to change
configuration settings for the browser. Don’t panic at the
dire warning that pops up. You really shouldn’t change
anything that you don’t know but you can do the
following: In the Filter box, type “network.prefetch-next”
[minus quotes]. Double-click the entry to set the value to
false. Close Firefox. When you search in Google, you
should stop getting the prompts to allow cookies.

.. . . . that you could delete some of your browsing history
but not all of it? In Firefox, press Ctrl-H to open your
History panel. Find the pages you no longer want, right-
click and select Delete. To get rid of a listing in the
address bar’s drop-down menu, point at the item with your
mouse and press Delete. If you use Firefox 3.0, the item
may lurk in the history long after it disappears from the
visible list. If you start typing the unwanted domain name
in the address bar, the drop-down screen will display the
tell-tale page. Delete as described above. For Internet
Explorer users, click Tools | History for a list of visited
sites. Right-click an entry you want to lose, and choose
Delete from the context menu.

.. . . . that Microsoft has many pages devoted to helping
you use their products? If you want to know how Word
handles page numbering, go to http://tinyurl.com/clnyo9.
If you look in the left side panel, you’ll find links to many
other pages where you might find just the help you need.
Try http://tinyurl.com/d3k6qm for tips on Word 2000.

.. . . . that you can make any folder into a toolbar? Click on
a folder and move it to the position where you want the
toolbar—top, bottom or side of your monitor. Hold the
folder in that spot for a few seconds, then release the
mouse button. A toolbar should appear. I put my folder for
Genealogy at the top of my screen and then chose Hide
Toolbar from the toolbar menu. When I want to use it, I
move my mouse to the top of the screen and the toolbar
opens with full access to all the sub folders and files
therein. Saves several clicks drilling down to find the files
I’m looking for. Wish I’d known this sooner. g

By the time you read this, you’ve probably heard that
Time Warner is getting set to raise their rates for PC users,
that is for PC users who use the Internet. They’re calling
this Consumption Based Billing. You will be billed
according to your particular use of the Net. If you do a lot
of movie downloading and/or use tons of gigabytes
utilizing cloud technology you will be charged more than
someone who is merely
browsing around in
those clouds. You will
be allotted just so much
[gigabytes?] and you
will be charged
accordingly. Someone
came up with the
analogy of a food menu; you will be charged more if you
order lobster than if you settled for a hamburger. Time
Warner has already tried this out in certain cities; the base
is expanding.

Magazines are also raising prices. Cover prices were
raised last year. Plans are to raise subscription prices this
year. It seems that there’s been a considerable decline in
media advertising, all media budgets have been slashed,
there are less reporters and news programs on hand, there
is less “product.”  Some newspapers went under; some
will be gone in the near future. How to save what's left?
There’s a lot left. Still, think of the rising cost of the
movie ticket, the cost of a subscription for cable
television, the coming rise of cost to the Internet user.
Everyone is paying more. Will people go for a magazine
price hike when they can and do get so much of their
news, politics, entertainment from TV, emagazines, blogs? 

Things get even more complicated for you, the
consumer of all this media/Internet information. Faced
with an ad market that no longer supplies enough revenue
to meet costs, newspapers are considering putting up pay
walls on their Web sites. Right now we're used to roaming
and browsing and meandering freely here and there on the
Net for some news or information. It seems that the
powers who claim ownership of these bits of information
will soon be asking you to pay for their content. 

Problem: who owns the content? Google reports news
on its site. Google has ads on its site and money from
those ads go to Google. But the news on the site is gotten
from AP. Is there a licensing agreement going on? Is
Google paying AP and all others who own the content
being printed under its site? I’m sure it will all get sorted
out and sooner or later it will be you and I and whoever
else is surfing the Net that will be paying for it. g

   Did You Know . . . — Donna Gorrell   
   Byting Remarks

— Jerry Finkelstein   

http://tinyurl.com/clnyo9
http://tinyurl.com/d3k6qm
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